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WELCOME 
Congratulations on your purchase of The T-Pain Effect, which includes The T-Pain Engine, The 
T-Pain Effect plug-in, and iDrum: T-Pain Edition. This guide will contain brief overviews of all three 
components, starting with The T-Pain Engine. You’ll be making beats, recording vocals, and sharing 
in no time! 

To learn more about all the products’ features, please see “Getting More Help” at the end of  
this guide.

Sincerely,  
The iZotope Team  

INSTALLATION 
Mac OS X 
1. Insert The T-Pain Effect disc into your DVD-ROM drive.  
2. Double-click on The T-Pain Effect disc icon on your desktop to view the disc’s contents.  
3. To start the setup program, double-click on the Install The T-Pain Effect icon.  
4. Follow the steps in the setup program. 

Windows 
1. Insert The T-Pain Effect disc into your DVD-ROM drive.  
2. If The T-Pain Effect web page does not appear automatically, double-click on the DVD-ROM  
    drive’s icon in Windows Explorer, and double-click on the “install_instructions.html” file.  
3. Click the “Install on PC” button to start The T-Pain Effect setup.  
4. If you are asked to “Open” or “Save” the file, choose “Open.”  
5. Follow the steps in the setup program. 
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AUTHORIZATION
Each purchased copy of The T-Pain Engine contains a unique serial number printed on the Installer 
DVD sleeve that will resemble:

SN-TPAINBUNDLE-XXXX-XXXX-XXXX-XXXX

Authorization
After installing your software, you will be prompted to authorize your software when first launching the 
product.

Your computer must be fully connected to the internet.

Note: If your computer is not connected to the internet, you can refer to the section 
below on Offline Authorization.

1. Click first on ‘Authorize’

2. Next, enter the serial number in all capital letters as it is shown on your DVD sleeve.

SN-TPAINBUNDLE-XXXX-XXXX-XXXX-XXXX

3. You must also enter your name and a valid e-mail address.

Make note of the e-mail address you use to authorize your license. Your license and iZotope account 
will be linked directly to this e-mail address.

4. When you have confirmed that your serial number and e-mail information is accurate, click once 
more on ‘Authorize’.

5. Lastly, click on ‘Submit’ in order to send your authorization message to the iZotope servers.

If the authorization is accepted, click on the ‘Finish’ button to complete the authorization.

Offline Authorization
Some customers choose to keep their audio workstations offline, and a simple offline authorization 
option has been included.

Note: If using The T-Pain Engine, you are encouraged to keep your workstation online 
in order to take advantage of the application’s Share and Listen features.

1. When first prompted to authorize your software, click first on ‘Authorize’.

2. Next, click on the option for ‘Offline Authorization’ at the bottom of the authorization window.

3. You will be given a unique Challenge Code that is specific to your computer only. Write down or 
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make a copy of the exact Challenge Code. It will look like this:

IZ-TPAINBUNDLE-XXXXXXXX-XXXX

4. Next, using a system with internet access, login to your customer account at the iZotope website.

http://www.izotope.com/store/account.asp

5. Click the ‘Activate Software with a Serial Number’ button, and submit your full serial number.

6. Select the ‘Challenge/Response’ option and enter your full Challenge Code copied in step 3.

7. After submitting your Challenge Code, you will receive a unique authorization file that you then 
need to move to your offline computer.

8. Once the authorization file is copied over to your offline music computer using a network, hard 
drive or USB stick, click the ‘Browse’ button in your authorization wizard.

9. Navigate and select the authorization file and click ‘Next’ to authorize your machine.
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THE T-PAIN ENGINE: QUICK START

Interface
The T-Pain Engine is a fun and simple way to make beats, record vocals and create songs that you 
can share.

Before diving in, let’s take a look at an overview of what The T-Pain Engine has got going on.

The T-Pain Engine has three Tracks for laying out your music.

(1) One track for your Beat

(2) Two tracks for your recorded Vocals

(3) The Mixer section at the bottom allows you to control the volume of each track

(4) Individual Mute buttons let you silence each track

(5) Check your audio levels with both Left and Right Meters

(6) The T-Pain Engine’s playback controls allow you to Play or Pause, jump Back to the beginning, 
Loop, Rewind or Fast Forward, and Record your incoming Vocal takes:

(7) The FX button reveals controls for the T-Pain Effect to process your Vocals:

(8) Set the Scale, Key and adjust the Style of the Vocal processing to fit your track 

(9) Click and hold on Beat Drop to temporarily cut out your Beat track

(10) Use the Export and Share buttons to save your track or share it online with your friends:

(11) Click the Listen button to explore the online community of The T-Pain Effect.
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Sound Check
When you first open The T-Pain Engine, we need to make sure that audio is passing in and out of 
your computer. 

The Sound Check walk-through has been created to help guide you through the process of getting 
your computer set up to record and playback your audio.

Sound Check will be displayed when launching The T-Pain Engine for the very first time, and is 
always available from the Sound Check button beneath the Recording meter, or from the Help menu.

Important Tip: Before you start, we recommend recording while using headphones 
instead of speakers—that way the sound of the speakers won’t leak into the microphone 
as easily.

Do not point the Mic at your speakers or loud feedback can occur.

If you don’t have headphones, start with your speaker volume low, and set up your microphone so it’s 
not right next to your speakers.

Once you’re either using headphones or your Mic is not pointing at your speakers, continue through 
the Sound Check walk-through’s on-screen instructions.
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THE T-PAIN ENGINE: First Steps

If you have not already done so, select Sound Check from the Help menu to make sure your  
computer is set up for recording.

Once we have audio running in and out of The T-Pain Engine, we can get started!

Beat
1. Select your Beat track in the upper left

2. From the Beats menu on the left, double-click on a beat to load it as a backdrop for your recorded  
    vocal ideas.
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Note: Preview any beat by clicking on the small play/stop 
buttons beside each beat in the list.

3. Each beat comes with multiple patterns marked with different colors for different sections of  
    the song, e.g. Verse 1, Chorus 2, etc.

4. Click anywhere in the ruler above your beat and press the play button to hear the arrangement.
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5. Click and drag to re-arrange your patterns,

or Click on the small drop-down button to swap out one pattern type for a different one.

6. Click and drag the green flag to make your beat longer or shorter.
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Vocals
Now that we’ve got the beat the way you want it, time to get your Vocals in.

7. Under the Choose a Track area, select Vocal 1

8. Click once on the circular Record button in order to arm your vocal track for recording.

9. Sing or talk into your Mic and you should see your voice in the Recording meter on the left.

Note: If you do not see any movement in the meters when singing into 
your mic, you may need to work through the Sound Check tutorial once 
more by clicking the Sound Check button beneath the Recording meter.
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10. By adjusting your singing technique or the input volume on your Mic, try to get your Recording  
      meter mostly within the Good section before recording.

11. When you’ve got your levels set, click the Play button and your Vocals will be recorded onto  
      Vocal 1 track.

12. Click the Play button again to finish your recording.

Note: If you are finished with your recording altogether, you can click again on the 
Record button to take The T-Pain Engine out of record mode.

13. To record more, you can redo your vocal take on Vocal 1, or select Vocal 2 from your Choose a  
      Track area and repeat Steps 8-12.

FX
Now that you’ve recorded your audio, let’s set up our effects.
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14. Click on the FX button to bring up the T-Pain Effect.

15. The Vocal key and scale of each Beat will already be loaded.

Try out different scales and keys to change up the sound of your track.

16. Use the Style sliders to adjust the character of the T-Pain Effect for both Vocal track 1 and 2.
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Mixdown
17. Next, use the Mixer controls at the bottom to adjust the levels of your Beat and Vocals.

18. When you’ve got your levels the way you want them, click Export to mix down your track into a  
      wav file on your computer.

19. Click Share to upload an MP3 of your track to your account on SoundCloud. 
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About SoundCloud®

SoundCloud is a free online music sharing service that allows users to upload songs to their own 
SoundCloud account. Once you have an account, you can easily share tracks through a variety of 
social media, including Facebook, Twitter, Tumblr, MySpace, email and more.

You will be prompted to create a free account if you don’t have one already. To configure your account 
for social media sharing, access your account on SoundCloud’s website and configure your Con-
nections settings. From there you can define which social media types will get updated anytime you 
upload a track from The T-Pain Engine.

Select the “Submit to The T-Pain Effect Group” checkbox when Sharing to automatically add your 
track to a SoundCloud Group dedicated to all creations made with The T-Pain Engine. This lets you 
show off your tracks to other T-Pain fans, and will also make you eligible for prizes and other give-
aways from iZotope and Nappy Boy!
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HOW TO LOAD PLUG-INS
Both The T-Pain Effect and iDrum: T-Pain Edition are plug-ins that can be opened inside of an audio 
application, often called a “host application.”

Loading The T-Pain Effect
Below are directions of one way to open an audio effect plug-in, like The T-Pain Effect, in several 
common host applications. Other applications have similar methods for loading a plug-in. Please 
consult your host application documentation for specific instructions.

Apple GarageBand
1. In the main view, select an audio track
2. Double-click on the track (or click the “Info” button) to bring up the Track Info pane
3. In the Track Info pane, select the Edit tab
4. Click in any of the blank slots to display a menu of available effects
5. Select “The T-Pain Effect” from the list

Ableton Live
1. In the main view, select “Plug-In Device Browser” (the plug icon) from the menu on the left  
2. From the list of “Plug-In Devices” double-click on “The T-Pain Effect.”
3. The T-Pain Effect will appear in the Audio Effects panel at the bottom of the main view.
3. To view the T-Pain Effect interface, click the wrench icon in the upper-left corner of the effect  
    module.

Apple Logic
1. In the “Arrange Window”, click on an audio track to select it.
2. On the left of the window, click and hold on an empty insert.
3. Select either the mono or stereo folder in the menu and then “The T-Pain Effect.”

Cakewalk SONAR
1. On an audio track, right-click on the “FX” section.
2. Select “Audio Effects”, then choose “The T-Pain Effect.”

MOTU Digital Performer
1. Open the “Mixing Board.”
2. Click and hold on an empty insert at the top of a track.
3. Select “The T-Pain Effect.”

Steinberg Cubase
1. Expand an audio track’s “Inserts” list.
2. Select one of the free slots.
3. From the pop-up menu, select “VST” and then “The T-Pain Effect.”

Other Hosts
Please consult your host application documentation or contact technical support.
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Authorization
The T-Pain Effect will continue to run with full functionality for 10 days. After this period, the output will 
periodically be silenced until the plug-in is fully authorized. When you are ready to authorize, have 
your serial number ready and launch the plug-in, then click the “Authorize” button.

Loading iDrum: T-Pain Edition
Below are directions for loading a virtual instrument, like iDrum: T-Pain Edition, in several common 
host applications. Other applications have similar methods for loading a virtual instrument. Please 
consult your host application documentation for specific instructions.

Note: iDrum: T-Pain Edition can also be used without a host, as a standalone applica-
tion. You can launch the iDrum application anytime from the folder in which you installed 
iZotope iDrum.

Apple GarageBand
1. Create a new track using GarageBand’s “New Track” menu item
2. In the New Track dialog, make sure the software instrument tab is selected.
3. Select “iDrum – Default” in the “Drum Kits” section and press OK
4. Double-click on the track (or click the “Info” button) to bring up the Track Info pane.
5. Single-click the icon in the iDrum Sound Generator slot to launch the iDrum interface.
6. Click GarageBand’s Play button and iDrum will start syncing to your song, playing its default  
    pattern.
7. Start experimenting by pushing buttons, or check out the iDrum Help file, located in the iZotope  
    iDrum install folder.

Ableton Live
1. In the main view, select “Plug-In Device Browser” (the plug icon) from the menu on the left  
2. From the list of “Plug-In Devices” double-click on “iZotope iDrum.”
3. iZotope iDrum will appear in the Audio Effects panel at the bottom of the main view.
4. To view the iDrum interface, click the wrench icon in the upper-left corner of the iDrum module.

Apple Logic
1. Select an Audio Instrument object.
2. Click-hold on the instrument slot and select iDrum from the iZotope sub-menu.
3. Logic automatically opens iDrum’s interface, and you’re ready to make some beats.

Cakewalk SONAR
1. Select “Insert” and “Soft synths” from the main menu.
2. Navigate to the “vstplugins” menu item and select “iZotope iDrum.”
3. From the Insert Options window, select “Simple Instrument Track” and “Synth Property Page”
4. SONAR will create new tracks dedicated to iDrum and automatically launch the iDrum interface.
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MOTU Digital Performer
1. From Digital Performer’s “Project” menu, choose “Add Track,” “Instrument Track,” and then  
    “iZotope: iDrum (stereo).”
2. Digital Performer will open the iDrum interfance and create a new Instrument Track with iDrum  
    inserted in the first slot.

Other Hosts
Please consult your host application documentation or contact technical support.

Authorization
iDrum: T-Pain Edition will continue to run with full functionality for 10 days. After this period, iDrum 
will not output sound until the plug-in is fully authorized. When you are ready to authorize, have your 
serial number ready and launch the plug-in, then click the “Authorize” button.
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THE T-PAIN EFFECT PLUG-IN: BASICS

The T-Pain Effect is a real-time audio effect 
that is designed to correct any incoming vocal 
pitches to a musical key or scale. The T-Pain 
Effect works by first recognizing the pitch of the 
audio that is being played through it, and then 
adjusting the pitch of that audio until it matches 
the nearest pitch of the key and scale The T-
Pain Effect is set to.

Use the drop down Key and Scale menus to 
select between any key root note and a collec-
tion of scales

You can then use the Style control to adjust how 
this processing is applied.

The T-Pain Effect will only work on monophonic 
music. That is to say, music or a vocal that only 
has one pitch at a time.

If you have vocals with harmony parts running through The T-Pain Effect together, the effect will not 
know which pitch to use.
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IDRUM: BASICS

iDrum is a virtual drum machine that allows you to create your own drum patterns either with its pre-
loaded sounds or by loading your own .wav or .aiff files. iDrum is similar to hardware drum machines 
that use what is called “step sequencing” to build patterns and songs.

With step sequencing, the drum machine loops over and over again, allowing you to enter notes on 
each track at different “steps” which each represent a rhythmic note in time. Each track in iDrum holds 
a different rhythmic sound, and many tracks together create a whole drum kit, allowing for unlimited 
possibilities!

In addition to working as its own sequencer, you can load iDrum into your favorite host sequencer and 
trigger each of its tracks from a MIDI track in your project.

To get started with iDrum, we recommend you play with it! Start with the drum kits and patterns we’ve 
included to get a feel for how iDrum works. If you’re new to the concept of programming a drum 
machine, start by loading a preset. Then click on the rectangles in the step sequencer to change the 
patterns. Drag up and down to change the loudness of each of the drum hits. iDrum lets you create 
new patterns quickly. When you’re ready, start loading in your own .wav or .aiff files and experiment. 

And remember, have fun! 
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Getting more help

The T-Pain Engine
For more help, please refer to the full T-Pain Engine help documentation. You can find this by either 
selecting Contents from the Help Menu in The T-Pain Engine interface or by finding the Help PDF in 
The T-Pain Engine installation folder.

The T-Pain Effect plug-in
For more help, please refer to the “The T-Pain Effect: Plug-in” chapter of the T-Pain Engine help docu-
mentation. You can find this by either selecting Contents from the Help Menu in The T-Pain Engine 
interface or by finding the Help PDF in The T-Pain Engine installation folder.

iDrum: T-Pain Edition
For more information, please refer to the full iDrum Help Documentation. You can find this Help Docu-
mentation in your installed iZotope directory or with iDrum visible, select ‘Help’ from the drop-down 
iDrum Menu in the upper left corner of the interface.



25The T-Pain Effect Quick Start Guide



26 The T-Pain Effect Quick Start Guide



27The T-Pain Effect Quick Start Guide



28The T-Pain Effect Quick Start Guide

Learn more about iZotope at www.izotope.com

Copyright © 2001-2011 iZotope, Inc. All rights reserved. iZotope®, iDrum® and the iZotope logo 
are trademarks or registered trademarks of iZotope, Inc. T-Pain, T-Pain Effect are copyrights and 
trademarks of Nappy Boy Enterprises, LLC, used with permission. SoundCloud® is a trademark of 
SoundCloud Ltd., used with permission. All other trademarks contained herein are the property of 
their respective owners. Other products and company names mentioned herein may be trademarks 
of their respective companies. This material is provided for information purposes only; iZotope, Inc. 
assumes no liability related to its use. Use of the software is subject to a related license agreement. 
All rights reserved.


